2.01
_____1. In preparation for an upcoming meeting, Liam is creating a PowerPoint presentation. If Liam would like to focus only on the content, which pane would be best suited for this purpose?
_____2.Which pane in Microsoft PowerPoint provides an area for placing reminders to help a presenter during a presentation?
_____3. Linda is using Microsoft PowerPoint for the very first time. While looking at her default screen, she notices that all of the elements are set in tabs. What are all of the commands on each tab called?
_____4. In Microsoft PowerPoint, what command is used to save an existing presentation with a new name or in a new location?
_____5. Steve is ready to begin developing the slides for his presentation. Which is the default slide layout for slide 1 of a new presentation?
_____6. After reviewing the PowerPoint presentation rubric for History class, Ava realizes that she should have used the same font in each slide. Which pane will allow her to quickly make this revision?
_____7. Mason has set up 5 slides in his new presentation and is ready to enter some text. He wants to enter text without having to think about other PowerPoint elements such as graphics, pictures, sound and animation. He just wants to focus on entering text. The best method for Mason to enter text is to use what feature of Microsoft PowerPoint?
_____8. In Microsoft PowerPoint, what command is used to save a new presentation?
_____9. Travis wants to make sure that his presentation is organized in the best arrangement. He needs to view as many slides as possible in one view. Which feature of PowerPoint should Travis view?
_____10.Which view displays each slide so that it fills the entire screen with no toolbars or other Windows elements visible on the screen?
_____11.Which of the following software programs is used to create a collection of slides that may contain text, charts, pictures, sound, movies, or multimedia, and is often called a presentation graphics program?
_____12. Cindy has created a report in her biology class using Word 2010 and would like to save time by using the content of that report to create a presentation. Which option under New Slide would she choose to import that information?
_____13. In Microsoft PowerPoint, where is the command located to undo the last action?
_____14.What is the name of the area that contains the zoom control and PowerPoint view buttons?
_____15.What area in the window contains the Quick Access Toolbar, filename, and Window control buttons?
_____16.What is the name of the view on the File tab that enables a user to manage files and data about files, and find frequently used features for managing PowerPoint presentation files?
_____17. In preparation for an upcoming meeting, Liam is creating a PowerPoint presentation. If Liam would like to focus only on the content, which feature should he use?
_____18. Keshawn has never used Microsoft PowerPoint before. He discovered a way to put his most commonly used commands together at the top of his screen for easy access. What is this customizable feature of PowerPoint?
_____19.Which tab shows a text-only display of each slide in the presentation?
_____20.What command is used to quit the current presentation on screen and quit the Microsoft PowerPoint program?
_____21. In the normal view what is the tab that displays at the left column of thumbnails?
_____22.What command is used to quit the current presentation on screen but leave the Microsoft PowerPoint program open?
_____23. In the Microsoft PowerPoint View Ribbon, which presentation view enables a user to view one slide at a time in the Slide Pane?
_____24.Which Microsoft PowerPoint pane shows the current slide as it will appear during the slide show?


A. Backstage
B. Close
C. Exit
D. Normal
E. Notes 
F. Outline
G. Outline
H. Outline
I. Outline
J. Outline
K. PowerPoint
L. Quick Access Toolbar
M. Quick Access toolbar
N. Ribbon
O. Save
P. Save As
Q. Slide
R. Slide Show
S. Slide Sorter
T. Slides
U. Slides from Outline
V. Status bar
W. Title bar
X. Title Slide
















2.02
_____1. Tammy is preparing to give a presentation. She would like to view information that will remind her what to say to her audience but that they will not see. Which view should she print?
_____2. In preparation for an upcoming presentation, Shanna is importing a document that includes the text into PowerPoint. Which of the following features should she use?
_____3. In Slide Sorter view, which method is used to change slide order?
_____4.Which command is used to insert slides from one presentation into another presentation?
_____5. As the newly elected president of FBLA, Mindy is creating a presentation to be used at the next meeting. She has created a slide that contains duplicate information and decides that it is not needed for an effective presentation. In slide pane view, Mindy can right-click the unnecessary slide and select which option?
_____6. Dave wants to print slides 7, 12 and 19-32 of his presentation at the same time. Which print option would allow Dave to enter the slide numbers that he wants to print?
_____7.What contains a predefined theme, sample text, and graphics on a slide or slide background to guide you as you develop your content?
_____8. As the newly elected president of FBLA, Mindy is creating a presentation to be used at the next meeting. She is finished with the slide she is working on and wants to insert another one in the default arrangement. In slide pane view, Mindy can right-click the current slide and click which option?
_____9.Which term refers to the boxes that hold text or objects on a slide?
_____10. Ashley has a limited supply of paper. Which print layout option will minimize the amount of paper used and includes up to nine images per page?
_____11. Pam is using the outline view in PowerPoint. She would like to reposition slide 2 to become slide 6. Which command should she use?
_____12. Sheila is using the outline view in PowerPoint. She would like to reposition slide 5 to become slide 2. Which command should she use?
_____13. Charles has asked his teacher to review his presentation and make suggestions for improvement within the file. Which print option allows him to print these suggestions?
_____14. David wants to quickly change the font color of the bulleted items on slides 2, 3, and 7 of his biology presentation. In which pane would he most easily accomplish this task?
_____15.Which group on the Home ribbon contains commands to create new slides in a presentation?
_____16.Which print setting creates printouts of an entire slide on the top of the page and an area for speaker notes below the slide?
_____17. Dave wants to print only the slide on which he is currently working. Which print option should he use?
_____18. Ashley wants to make a printed copy of her presentation exactly as shown to her audience. Which print option should she use?
_____19.Which print setting enables multiple slides to be printed on one page?
_____20. Travis wants to give his audience a sheet to follow along and make notes during his presentation that includes representations of each slide. Travis should utilize which feature of PowerPoint?
_____21. Charles has several slides in his presentation which are either smaller or larger than the paper size in the printer. Which print option should he use to ensure that each slide utilizes the maximum print area?
_____22.Which area in the Print dialog box is used to change the default printer?


A. Custom Range
B. Delete Slide
C. Drag and drop to new location
D. Full Page Slides
E. Handouts
F. Handouts
G. Handouts
H. Move Down
I. Move Up
J. New Slide
K. notes page
L. Notes Pages
M. Outline
N. Outline Pane
O. Placeholder
P. Print Comments and Ink Markup
Q. Print Current Slide
R. Printer Status Dropdown
S. Reuse Slides
T. Scale to Fit Paper
U. Slides
V. Template



















2.03
_____1. Pam is using the outline view in PowerPoint. She would like to lower selected text from level 1 to level 2. Which command should she use?
_____2. Mason has set up 5 slides in his new presentation and is ready to enter some text. He decides to put his text in a box with a dotted outline, designed for the placement of content on the slide. What is this referred to?
_____3. Gregory is making a presentation to encourage fellow students to join the prom committee. He would like to emphasize the date of the first meeting by making it bold. Which of the following would include options for accomplishing this?
_____4.What type of list has an entry proceeded by a symbol?
_____5.Which text alignment command aligns text with both the left and right margins of a slide and adds space between words as needed?
_____6. Gregory is making a presentation to encourage fellow students to join the prom committee. Which of the following would include options for accomplishing this?
_____7. Keisha wants to change the font color on the 1st and 3rd bulleted items on slide 6 of her Allied Health Presentation. What is the best way to select both bullets at the same time?
_____8.Which type of text may be formatted to print at the top of every page?
_____9.What feature automatically revises typing errors based upon information contained in Microsoft Office 2010’s standard dictionary?
_____10.Which term refers to the size of alphabetic and numeric characters on a slide?
_____11.Which command is used to change the orientation of text in a text box to vertical, stacked, or rotated?
_____12. Rachel wants to add a long quotation to her presentation. What type of text is this?
_____13. Rachel would like to add a list to one of the slides in her presentation. Which of the following should she use?
_____14.What does the wavy, red line under a word in a presentation mean?
_____15. Fred wants to give his FBLA presentation about the upcoming membership drive an intense look. Fred should use which PowerPoint feature that includes pre-programmed settings that specify degrees of intensity for fills, lines, and special effects such as shadows and bevels?
_____16.Which ribbon includes the command to create presentation slides from an outline?
_____17. Andy is creating a presentation about seatbelts. He finds himself using the word "save" repeatedly in his presentation. What feature could he use to find a synonym for this word?
_____18. Keisha's does not want the text on slide 3 to run out of the textbox and she wants the textbox to remain the same size. How can she prevent this?
_____19. Maria adds text to a bulleted list on slide 5 of her presentation. On the text that she adds, she does not want a bullet. Using commands on the Home tab, how does she remove the bullet that automatically appears?
_____20.Which ribbon contains the command to insert a text box on a slide?


A. AutoCorrect
B. bullet text
C. Bulleted list
D. Bullets
E. Ctrl + click
F. Demote
G. Effects
H. Font Effects
I. Font size
J. Font Style
K. Header
A. Home
L. Insert
M. Justify
N. Misspelling
O. paragraph text
P. Placeholder
Q. Shrink text on overflow
R. Text direction
S. Thesaurus

























2.04
_____1. Mr. Jones has a very lengthy MSITA class presentation; he has decided to share handouts with the class. What feature in the Header and Footer dialog box will help keep the pages in order?
_____2. Sharon wants to include her name on each slide in her science presentation. Where in the Header and Footer dialog box would she type her name?
_____3. Trey is creating a PowerPoint for his Chemistry class. He wants to make sure all the slides have a similar visual appeal. Which tab would he choose to ensure that all slides have a single theme?
_____4. Mr. Jones is creating handouts for his MSITA class presentations. What feature in the Header and Footer dialog box would allow him to add the class name to the bottom?
_____5. Janice wants to create a presentation that contains bold fonts, colors and effects. Which group on the design tab will be best suited for this task?
_____6. Sharon wants to be able to quickly locate the 12th slide in her science presentation. Which option in the Header and Footer dialog box would she select?
_____7.Which ribbon contains the command to create a link to a new location?
_____8. Sheila is using the outline view in PowerPoint. She would like to view the detailed content of all of her slides. Which command should she use?
_____9.What is the text that appears on every slide but, depending on the theme applied, may not always appear at the bottom of a slide?
_____10.What is applied to text or an image in a slide that enables a user to jump to a new location by clicking on the text or image?
_____11.What command on the Home ribbon enables a user to change the design of a slide after it has been inserted into a presentation?
_____12. In her history presentation, Bobbie wants to include her class period on all slides except the first. Which option in the Header and Footer dialog box would she select?
_____13. Mr. Jones is creating handouts for his MSITA class presentations. What feature in the Header and Footer dialog box would allow him to add the class name to the top?
_____14. Sharon wants to add the date to her science presentation. She wants the date to remain the same each time it is opened. Which of the following in the Header and Footer dialog box would she select?
_____15. In her history presentation, Bobbie wants to include her class period in the footer only on the current slide. Which option in the Header and Footer dialog box would she select?
_____16. Fred wants to give his FBLA presentation a designer-quality look - a look that includes one or more slide layouts with coordinating colors, a matching background, fonts, and effects. Fred will want to apply which PowerPoint feature to his presentation?
_____17.Which term refers to a predetermined way of organizing objects on a slide including title text and other content?
_____18. Janice would like to number the slides in her presentation. Which command on the design tab would be best suited for this task?


A. Apply
B. Date and Time (Fixed)
C. Design
D. Don't show on title slide
E. Expand All
F. Footer
G. Footer
H. Footer
I. Header
J. Hyperlink
K. Insert
L. Layout
M. Layout
N. Page number
O. Page Setup
P. Slide number
Q. Theme



























2.05
_____1.What is applied to a table in a slide to format the borders around the table and cells and to select a color scheme?
_____2. Daphnie is working on her FBLA membership table and wants to format the first column of her table differently than the rest of the table. What feature would she use?
_____3. John wants to change the style of a table in his presentation. After he has selected the table, which tab should he use?
_____4.Which ribbon contains the command for applying Table Styles to a table in a slide?
_____5. Daphnie is working on her FBLA membership table and wants to make it easier to distinguish between rows. What feature would she apply to the rows in her presentation?
_____6. Kurt is editing a table in his PowerPoint that displays accounting formulas and when to use them. He wants to separate one cell into two. What feature would he use?
_____7. Kurt is editing a table in his PowerPoint that displays accounting formulas and when to use them. He wants to remove the table style formatting. What feature would he use?
_____8. In a table, what is the intersection of a column and a row called?


A. banded columns
B. banded rows
C. Cell
D. Clear table
E. Design
F. Split
G. Table Styles
H. Table Tools Design
















2.06
_____1. Amelia has selected the chart in her PowerPoint and needs to change the chart type. Which tab would she use?
_____2. Susie wants to show the growth in her business classes as values in a PowerPoint presentation. What type of chart would she use to display the values as horizontal rectangles?
_____3. Beau needs to align a chart in a PowerPoint. Which tab would he use?
_____4. Joan's business class is participating in the Hop on the Bus stock market game. She needs to track the stock prices over time and display the information in chart form for her PowerPoint.  What type of chart would she use?
_____5.What is inserted into a slide to illustrate the data from a spreadsheet?
_____6.Which group on the Insert Ribbon contains the command to insert a chart into a slide?
_____7. John wants to insert a chart into a slide on his PowerPoint. Which group on the Insert tab would he use?
_____8. Linda is creating a PowerPoint on which schools in North Carolina are offering the Microsoft Certification courses. Which feature would she use to show the purpose of the chart in the presentation?
_____9. Matt wants to show the percentage of students who have passed the PowerPoint Microsoft Office Specialist certification out of all the students who have earned certifications. Which type of chart should he use?
_____10. Linda is creating a PowerPoint on which schools in North Carolina are offering the Microsoft Certification courses. To identify the vertical and horizontal values in a chart. Which feature would she use?
_____11. Mrs. Perry is using a graphic shows her employees a series of incentives they could earn based on performance. Which SmartArt graphic should she use?
_____12. Mrs. Pickard wants to show the chain of command in the corporate headquarters. Which SmartArt graphic should she use?
_____13.Which feature allows you to create graphical lists and process diagrams easily and quickly?
_____14. Mrs. Pickard, the FBLA advisor, wants to show the proportion of competitors at the regional, state, and national level from each school. Which SmartArt graphic layout should she use?
_____15. Mrs. Perry wants to graphically compare the number of employees with associate, bachelor, master and doctorate degrees. Which SmartArt graphic should she use?
_____16. The CEO of Microsoft wants to show the repeating process of how many times they launched a new version of office using a smart art graphic. What smart art layout would they use?


A. Axis title
B. Bar
C. Chart
D. Chart title
E. Cycle
F. Design
G. Format
H. Hierarchy
I. Illustrations
J. Illustrations
K. Line
L. List
M. Pie
N. Pyramid
O. Pyramid
P. SmartArt

























2.08
_____1. The thickness of the line around a picture frame is called:
_____2.Which of the following terms refers to combining multiple objects into a single object?
_____3.Which of the following includes illustrations, photographs, videos, and audio stored in collections for easy access?
_____4. The line format in which dotted, dashed, or solid lines options appear is called the:
_____5.What command is used to color a shape that you have drawn on a slide?
_____6.Which frame may be applied after inserting pictures into Microsoft PowerPoint?
_____7.Which ribbon contains the command to flip or rotate a shape on a slide?
_____8. Keisha wants to resize the graphic on slide 4 of her Allied Health presentation. What is the first step to accomplish this task?
_____9.Which command is used to remove any unwanted parts of a picture in a slide?
_____10.What group on the Picture Tools Format ribbon contains the command to right align images in a slide?
_____11.What is the purpose of using the corner resizing handles to resize a graphic?

A. 
B. Arrange
C. Border
D. Clipart
E. Crop
F. Drawing Tools Format
G. Grouped
H. Line style.
I. Line weight.
J. Select
K. Shape Fill
L. To maintain aspect ratio of the graphic
















2.09
_____1.Which commonly used animation effect makes text on a slide appear in the presentation?
_____2. Tanya has a picture on slide 6 of her presentation that has an entrance animation; she would also like for it to have an exit animation. Which of the following would you apply to cause this to happen?
_____3.Which command is used to specify the length of the transition effect for each slide in a presentation?
_____4.Which option indicates that a presentation should wait for a mouse click prior to moving to the next slide?
_____5. Mark is customizing his AP US History PowerPoint on the Vietnam War. He wants to add visual interest to his jet fighters on slide seven and have the fighters to fly in on the slide. Which tab would he chose to complete this customization?
_____6.Which ribbon contains commands that apply an entrance effect to a chart?
_____7. Daniel wants each slide to appear with a checkerboard effect. Which of the following would you apply to cause this effect?
_____8. Tanya wants to apply the same animations from slide 3 to slide 5. Which of the following would you use to complete this task?
_____9. Katherine has included audio in her Career Management presentation. She does not want the sound clip icon to display during her slideshow. What option does she select on the Audio Tools Playback tab?
_____10.What are movements from one slide to another during a presentation called?
_____11. Tanya wants slide 1 to stay on the screen for 30 seconds. Which of the following would she use to complete this task?
_____12. John has completed his History of the Automobile PowerPoint. In order to maintain audience interest he inserts on each slide a picture of a horn which beeps only when mouse clicked. Which animation feature would create this result?
_____13.Which command is used to view the various options that can be applied to an animation?
_____14.Which ribbon appears to allow a user to control how a sound clip plays?
_____15. Tanya needs to reorder her animation on slide 4. Which of the following would she use to complete this task?
_____16.Which effect adds interest to a slide show and focuses audience attention on important points by adding entrances, emphasis, motion paths, or exits to text or objects?
_____17.Which command is used to insert a sound clip into a slide?
_____18. Evan completed his Accounting PowerPoint and decided that his animations on slide 3 need to be switched to create a more audience friendly presentation. Which animation feature should he choose to complete this change?
_____19. T.J., the drum major for the band, designed a PowerPoint for Homecoming which animates how each section of the band will be introduced on the field. He wants to reverse the order of the entrance of drums and french horns on slide seven. Which feature would he choose to complete this order change?
A. 
B. Add Animation
C. Animation
D. Animation
E. Animation Painter
F. Animation Pane
G. Animation Pane
H. Animations
I. Audio
J. Audio Tools Playback
K. Duration
L. Duration
M. Effect Options
N. Entrance
O. Hide During Show
P. On Mouse Click
Q. Reorder Animation
R. Transition
S. Transitions
T. Trigger


























2.10
_____1. Owen wants to secure his presentation so that no one can make changes to it. What feature could he use that requires a security code to open or edit the presentation?
_____2. Garrett wants to secure his PowerPoint so that he is the only one that can make changes to it. What feature could he use that requires a security code to open or edit the presentation?
_____3.When saving a presentation that will be exported to Microsoft Word 2010, which file type should be selected?
_____4. Mrs. Thomas, FBLA state adviser, wants to remove hidden properties and personal information in a PowerPoint she is sending. Which feature should she use?
_____5. Owen wants to look for hidden properties and personal information in a presentation that he create. Which feature would he use?
_____6. Holly wants to send a PowerPoint presentation to a group of people in an email. How would she send it?
_____7. Owen wants to approve and ensure the integrity of his presentation. Which feature of PowerPoint should he use to assure viewers that his PowerPoint is authentic?
_____8. Holly created a membership presentation in the most current version of PowerPoint. She wants to make sure that all features of her presentation will be visible in older versions of the software. Which feature would she use?
_____9. Garrett is sending his presentation to the national FBLA office and wants to ensure its integrity. What feature should he to add to his presentation?
_____10.What appears on a slide to indicate there is a note or remark about the slide and the initials of the person who made the note?


A. .rtf
B. Add a Digital Signature
C. Add a Digital Signature
D. Check for compatibility
E. Comment
F. Encrypt with Password
G. Encrypt with Password
H. Inspect the document
I. Inspect the document
J. Send as Attachment











2.11
_____1. Pam is reviewing a PowerPoint she is planning to present during FBLA State Leadership Conference. She is in the outline pane and would like to hide the detailed content of all slides. Which command should she use?
_____2. Mason has set up 5 slides in his new presentation and is ready to enter some text that he does not want his audience to see. This text will be a reference for him and is hidden during the presentation. The place Mason will insert important key points that he wishes to cover during the presentation is located where?
_____3. Garrett is preparing to give a presentation for his FBLA competition. Which command would he used to test animations on a slide before delivering the presentation?
_____4. Bill is doing a presentation for his Art I class using his yearbook pictures since kindergarten. Since the pictures are taller than wide, he will need to change his slides to which of the following in the Page Setup dialog box?
_____5. Juan created a PowerPoint in his Business Law class to present forms of business ownership. He wants to customize this PowerPoint to use in Marketing class and only use the slides on corporations and partnership. Which tab would he choose to complete this customization?
_____6.Which command is used to test animations on a slide before delivering the presentation?
_____7. One of Janice's presentation slides has content that is taller than it is wide. Which command on the design tab would she use to change this?
_____8.Which command is used to record the time a presenter spends on each slide in order to run the show automatically in the future?
_____9.Which ribbon contains the command to hide a slide so that it does not show during the full-screen slide show?
_____10. Pam is using the outline view in PowerPoint. She would like to hide the detailed content of all of her slides. Which command should she use?
_____11.When creating a custom slide show, which dialog box enables a user to select individual slides to include in the custom slide show?

[bookmark: _GoBack]
A. Collapse All
B. Collapse All
C. Define Custom Show
D. Notes Pane
E. Portrait Orientation
F. Preview
G. Preview
H. Rehearse Timings
I. Slide Orientation
J. Slide Show
K. Slide Show




